Alibaba Cloud

Quick BI

Document History

Document Version: 20211224

(-] Alibaba Cloud



Quick BI Document History-Legal disclaimer

Legal disclaimer

Alibaba Cloud reminds you to carefully read and fully understand the terms and conditions of this legal
disclaimer before you read or use this document. If you have read or used this document, it shall be deemed
as your total acceptance of this legal disclaimer.

1.

You shall download and obt ain this document from the Alibaba Cloud website or other Alibaba Cloud-
aut horized channels, and use this document for your own legal business activities only. The content of
this document is considered confidential information of Alibaba Cloud. You shall strictly abide by the
confidentiality obligations. No part of this document shall be disclosed or provided to any third party for
use wit hout the prior written consent of Alibaba Cloud.

. No part of this document shall be excerpted, translated, reproduced, transmitted, or disseminated by

any organization, company or individual in any form or by any means without the prior written consent of
Alibaba Cloud.

. The content of this document may be changed because of product version upgrade, adjustment, or

other reasons. Alibaba Cloud reserves the right to modify the content of this document without notice
and an updated version of this document will be released through Alibaba Cloud-aut horized channels
from time to time. You should pay attention to the version changes of this document as they occur and
download and obt ain the most up-to-date version of this document from Alibaba Cloud-aut horized
channels.

. This document serves only as a reference guide for your use of Alibaba Cloud products and services.

Alibaba Cloud provides this document based onthe "status quo", "being defective", and "existing
functions" of its products and services. Alibaba Cloud makes every effort to provide relevant operational
guidance based on existing technologies. However, Alibaba Cloud hereby makes a clear statement that
it in no way guarantees the accuracy, integrity, applicability, and reliability of the content of this
document, either explicitly or implicitly. Alibaba Cloud shall not take legal responsibility for any errors or
lost profits incurred by any organization, company, or individual arising from download, use, or trust in
this document. Alibaba Cloud shall not, under any circumstances, take responsibility for any indirect,
consequential, punitive, contingent, special, or punitive damages, including lost profits arising from t he
use or trust inthis document (evenif Alibaba Cloud has been notified of the possibility of such a loss).

. By law, allthe contents in Alibaba Cloud documents, including but not limited to pictures, architecture

design, page layout, and text description, are intellectual property of Alibaba Cloud and/or its
affiliates. This intellect ual property includes, but is not limited to, trademark rights, patent rights,
copyrights, and trade secrets. No part of this document shall be used, modified, reproduced, publicly
transmitted, changed, disseminated, distributed, or published wit hout the prior written consent of
Alibaba Cloud and/or its affiliates. The names owned by Alibaba Cloud shall not be used, published, or
reproduced for marketing, advertising, promotion, or ot her purposes wit hout the prior written consent of
Alibaba Cloud. The names owned by Alibaba Cloud include, but are not limited to, "Alibaba Cloud",
"Aliyun", "HiChina", and other brands of Alibaba Cloud and/or its affiliates, which appear separately or in
combination, as well as the auxiliary signs and patterns of the preceding brands, or anyt hing similar to
the company names, trade names, trademarks, product or service names, domain names, patterns,
logos, marks, signs, or special descriptions that third parties identify as Alibaba Cloud and/or its
affiliates.

. Please directly contact Alibaba Cloud for any errors of this document.
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Document conventions

Style

/\ Danger

warning

) Notice

@ Note

Bold

Courier font

Italic

(1 or [alb]

{} or {a|b}

Description

A danger notice indicates a situation that
will cause major system changes, faults,
physical injuries, and other adverse
results.

A warning notice indicates a situation
that may cause major system changes,
faults, physical injuries, and other adverse
results.

A caution notice indicates warning
information, supplementary instructions,
and other content that the user must
understand.

A note indicates supplemental
instructions, best practices, tips, and
other content.

Closing angle brackets are used to
indicate a multi-level menu cascade.

Bold formatting is used for buttons ,
menus, page names, and other Ul
elements.

Courier font is used for commands

ltalic formatting is used for parameters
and variables.

This format is used for an optional value,
where only one item can be selected.

This format is used for a required value,
where only one item can be selected.

Example

& Danger:

Resetting will result in the loss of user
configuration data.

warning:

Restarting will cause business
interruption. About 10 minutes are
required to restart an instance.

p Notice:

If the weight is set to 0, the server no
longer receives new requests.

@ Note:

You can use Ctrl + A to select all files.

Click Settings> Network> Set network
type.

Click OK.

Runthe cd /d C:/window command to
enter the Windows system folder.

bae log list --instanceid

Instance_ID

ipconfig [-all|-t]

switch {active|stand}
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1.Release notes for Quick Bl V3.12.2

This topic describes the release notes for Quick Bl V3.12.2 and provides links to the relevant references.

Release date
August 2021

Data sources
e Self-managed GBase data sources are supported. For more information, see Add a self-managed
GBase data source.

e Data sources of the ApsaraDB PolarDB PostgreSQL-compatible edition are supported. For more
information, see Add a data source of the ApsaraDB PolarDB PostgreSQL-compatible edition.

e Hologres data sources are supported. For more information, see Add a Hologres data source.

e Self-managed Snowflake data sources are supported. For more information, see Add a self-
managed Snowflake data source.

e Self-managed Impala data sources are supported. For more information, see Add a self-managed
Impala data source.

e Self-managed Kylin data sources are supported. For more information, see Add a self-managed Kylin
data source.

e Data sources of ApsaraDB ClickHouse, AnalyticDB for MySQL V3.0, and Distributed Relational Database
Service (DRDS) are supported. For more information, see Add an ApsaraDB for ClickHouse data source.

Add ClickHouse Database %

* Name:
* Database Address:
* Port Number: 8123
* Database:
* Username: quickbi_irain

* Password: sesessssssses

VPC Data Source:| | @

(1) Mote: Add the following IP addresses to the whitelist

Cloze ‘ | Test Connection ‘ “

e Quick Blis compatible with the ApsarabDB PolarDB MySQL V8.0-compatible edition.

e ApsaraDB for OceanBase data sources are supported.

e The configuration items for Dataphin data sources are optimized.
The schema parameter is changed from a required parameter to an optional parameter.

e The maximum allowed size of an Excel file that can be uploaded to a data source is increased from
20 MBto 50 MB.
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For more information, see Create a file data source.

e Only administrators are allowed to create data sources. Developers do not have permissions to
create data sources.

Datasets

e The dimension type can be images. For more information, see Edit a dimension.

e The Use authorization operation is supported to specify the users who can perform operations on
a specified dataset. For more information, see Manage datasets.

e The data source of a dataset can be changed to another data source that is of the same type as the
original data source. For more information, see Optimize dataset performance.

Dataset

MySQL

My SQL

MaxComputeTest

cloud data source MySQL

Dashboards and chart analysis

e The filter bars are upgraded.

o When Display type is set to Tree drop, Multiple choice is supported forinquiry mode.
o The Reset and Clear icons are added.

o The section that is used to customize time granularity details is optimized. This section appears
when Display type is set to Date selection.
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o Whenyou use afilter barto query data based on a text field and set the Display type parameter
to Drop-down list (formerly enumerated filter) or Tree drop, Pre-query is supported for the Query

time parameter.

If Pre-query is selected, you can select a value fromthe drop-down list in the filter bar on the
dashboard. The values displayed in the drop-down list are determined based on the configuration
of row-level permissions. The default value that is displayed for each account varies based on the
configuration of row-level permissions.

Related charts an..Q

select all

»/ Line Chart (Ri...
</ Line Chart (Dr...
«/ Line Chart (Til...
«/ Line Chart-com...

=/ Line Chart

company_sal...

company_sal...

company_sal...

company_sal...

company_sal...

Field smart ... @ Query condition configuration Make required

Clear selected field Basic configuration W
Display type  Drop-down list (formerly enumerated filter)

Option val..
Automatic parsing @ Single data set Enter manually

company_sales_record_en_0710

* Query Val._. Str order_level
+ Quary nam. Str order_level @
Sorting F. Str province As..

nquiry mode Single choice @ Multiple choice

Str order_level b

Query time @} Click to query Pre-guery (D

Set filter defaults (0

For more information, see Create a query control.

e Visual analysis

o Field filters for dashboard components and workbooks are upgraded.

For more information, see Query data based on a date field.

o Data ranking is supported for cross tables of the latest version and ranking boards. For more

information, see Data ranking.

Ranking Board Indicator (Measures) 111
Or... area order_number_Ranking order_amt order_number(SUM-Ranki...

1 Center ] 3 490K

3 East EE—— 5 520K Auxiliary indicators (Mea.) @ 1/3

3 Norih ] 4 408K order_amt(SUM)

4 Mortheast 5 500K

5 Northe:st 6 217K Filters

&  South ——— 1 817K

7 Southwest I 7 24 5K
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o The Yearly Cumulative Value option is supported for measures. For more information, see
Cumulative calculation.

Cross Table of New Version

Rows
repori_date(day) order_number order_number_SUM_Monthly Cumulative Value order_number_SUM_Quarterly Cumulative Value order_number_SUM_Current Y&

report_date(day)

20090119 157 998 998
n
20090121 17 1.01K 101K
Columns

20090122 59 1.07K 1.07K

order_numben(SUM)
20090123 1.84K 291K 291K

order_numben(SUM-Monthl...
20080124 12 292K 292K order_numben(SUM-Quarte...
EL 13 2.94K 2.94K order_numben(SUM-Curren...
20090126 81 302K 302K order_number(SUM-Yearly ___
20090128 124 314K 314K

Total: 643 2 345 33 > | 20/page Goto

m The Comparison option is not supported for measures.
m Cumulative Calculation is supported only for measures marked with SUM, such as
=TT

m Cumulative Calculation is supported only when the dimension contains one date field
and its time granularity is year, quarter, month, week, or day.

o The percentile and median aggregation methods are supported for measures. For more
information, see Configure a measure field.

The following table describes the aggregation methods supported by different data sources.
Data source Supported aggregation method
All data sources that can connect to Quick BI SUM, AVG, COUNT, COUNT DISTINCT, MAX, and MIN

MySQL, Vertica, SAP IQ (formerly known as Sybase
IQ), SQL Server, Presto, Postgre Plus Advanced
Server (PPAS), PostgreSQL, Oracle, MaxCompute,
Hive, SAP HANA, AnalyticDB for PostgreSQL,
GBase, IBM DB2 for LUW, Clivia, ClickHouse, and
AnalyticDB for MySQL V2.0

Population Standard Deviation, Sample Standard
Deviation, Population Variance, and Sample
Variance

HBase Population Standard Deviation

SAP IQ (formerly known as Sybase IQ), Oracle,
MaxCompute, SAP HANA, IBM DB2 for LUW, Presto,
HBase, AnalyticDB for PostgreSQL, and
PostgreSQL

Median

SAP 1Q (formerly known as Sybase IQ), Oracle,
MaxCompute, SAP HANA, IBM DB2 for LUW, and Percentile
ClickHouse
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o The export feature for dashboard components is upgraded. The export feature for workbooks is
also upgraded.

m The Export to Image and Export to PDF options are combined into the Export icon.
m The EXCEL option is added to allow you to export dashboards and workbooks as Excel files.
m Dashboards and workbooks can be exported to Object Storage Service (0SS) buckets.

For more information, see Manage dashboards.

o The Data Display Format parameter is moved fromthe Series Settings sectionto the Datatab.
This allows you to view data display formats of measures and configure data display formats for
multiple measures at a time in an efficient manner.

m The Data Display Format parameter is optimized and moved to the Data tab.

m Batch alignment is supported for cross tables and ranking boards.

Order profit details
Rows
area province  city product e product sub_type  order_level  shioping_ype  product_box report_date(year) order_number  order_amt  backpoint  proft_amt  price  shipping_cost —
Gent H A o
enter enan nyang Fumiure Ghair others Truck Huge Box 200 3 566K o 1.06K 161 20 —
offce Envelop s Tran Small Box 2012 15 180 0.04 an e 697 ay
Paper L Tran Small Box 2010 a 979 0.0 Bl 20 586 T
undefined L Train Small Box 2000 4 351K 005 pE 897 20 product_sub_type
Others Tran Small Box 2010 2 133 0.08 103 424 san order_level
Hebi Office undefined Others Train Small Box 2009 50 877 0 127 % 132 ‘shipping_type
Jisozuo Fumiture Table 4] Truck Huge Paperbag 2010 33 617K 0.03 -433 179 292 DISEILE]
offce Box L2 Train Small 8ox 2009 2 384 0.03 21 122 481 repatiiaeyes)
B "
20m % 604 on 27 27 183
Columns
Pen L2 Tran Paperbag 2010 a 158 o 6 328 397
order_number(SUM)
others Tran Paperbag 2009 6 203 017 82 167 199
Luche Technique Accessory s Tran Small Box 2010 7 68 012 02 57 753
Wachines u Truck Huge Box 2009 1 273K 0 S57K 255K 297
profit_ami(SUM)
Telephone 5 Train Small 8o 2010 3 253K 0 7 E 279
g price(sUM)
L Fumit
uoyang umiture Chair L2 Truck Huge Box 2011 37 126K 0.06 333K 351 B T el
Decorator L2 Tran Small bag 2012 37 832 0.04 175 227 ag9
offce Latel others Plain Small Box 2012 68 484K 0.04 158K 145 187 Fiters
Paner 1" Tran Smal Ao 2012 3 21 nos Et san 744
Total: 991 2345 50 > |20/page ¥ | Goto

m Batch configuration of aliases, aggregation methods, and value display formats is supported.

Dala
Pie Chart
Central Angle (Mea) @ 4/10

= order_number(SUM)
order_amt(SUM)

back_point(SUM)

Technique 22 34%
profit_ami{SUM)

Labels (Dim.)

product_type

Office 54.55% Filters

Furniture 23.11%
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Quick BI

m Measures can be renamed.
Data

Ceniral Angle (Mea.) &4

= order_number(AVG)

SUM

T DISTINCT

ulation

ay Format

For more information, see Configure multiple measure fields.

o The data comparison feature is supported for line charts. For more information, see Add data

comparison.

Line Chart

I o same time last year [ o lastwesk M .o 2021-35 week ¥ Show auxiliary lines

40K -
order_amt
® 2072-50 12.5K
30K o (same time last year) 2011-50 1.58K
19.6K
£ \ FAA -
= .
SR\
: :
; o

]

4 \/ \/ W) \ /
o - o . o
) K ) &) ) z 2 & 2 & % % e e e e e © )
“ < B % < AT < < < T I T L 4 D%
% % % D 2 % 0% 0T % % b %
2012-30 2012-52

e Trend indicator charts are optimized.

10
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o Secondary Y-axes are supported.

order_number order_amt back_point profit_amt
9.29K 703K 18.5 94.7K
= order_ami = profit_amt
™ 120K
900K 100K
800K 80K
700K 60K
600K 40K
2009 2010 2011 2012

o The display formats for secondary Y-axes can be configured.

Data Advanced

¥ Show Trend by Date

Overall Tr... Detailed T...

Change Charts

-/ I

Line Chari  Vertical B...

Custom Trend Chart Color

Color Settings EE I Official

Date Duration ; Day

Select Preview Mode

Single Choice ® Multiple Choice

Layout for Multiple Indicators

Displayed in One Line

splayed in Multiple Lines

Right Y-Axis

Label Seitings

® AutoFit Customer Manual

AutoFit (English)
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o Trend charts can be switched between line charts, area charts, and column charts.
order_number order_ami shipping_cost order_number order_amt shipping_cost order_number order_amt shipping_cost
36 2.05K 3.99 36 2.05K 3.99 36 2.05K 3.99
- order_number - order_amt - profi_amt w order_number = order_amt  mw profit_amt - order_number - order_amt - profi_amt
25K 25K 25K
20K 20K 20K
15K 15K 15K
10K 10K 10K
5K 5K K ) /\A
o — 0 - o s
5K 5K -5K
N N NN NNNNNNNBKNNN N NN N NNNMKNRKNLNNRLNDNLN N N N NNNNLNNNBKNNRKRNN ]
o The styles, sizes, and layouts of axes are upgraded.
order_number order_amt back_point profit_amt
36 2.05K 0.02 484
- order_amt = profit_amt
30K 8K
25K 31,4
20K 4K
15K 2K
10K 1]
5K 2K
o -4k
< <0y <0y 0y <07 <07, < < < < < < C0r. C0r. SOy C0r - 08 CO0r - CO0r - 0. SOy L0 - < T T < <) < <
072707 55075507 5207 4 =07 5,207 5 <0 5 07 507 3 <07 507 5 <0y 3 <07 o <07 3 <07 5 <0y 5 0 5 <0 5207 5 07 5 <07 3 <0 <07 <07 5,207 520 507 507 5507 5
035 1027 1055 1025 1025 1055 7035 7057 gy T iag Tiag Thag 1115 T ag Thas Uiz Thag T205 1205 M0y 120y 1206 121G 120y 12y s T2y 1225 ey Mg

o When you move your pointer over a general trend chart that shows the trends of all specified
measures, a tooltip that provides the value of each measure on the corresponding date appears.

order_number

36

30K
25K
20K
15K

10K

07,0y, <07, <07, <07, <!
0{_;{.,5?0‘;, 0?310*3; 01257075

<0
27 12
027 5 '9-?5

207,207
2,
03) "O\Jg /030

<oy
703;’

<p,

¥/

order_amt

2.05K

<0;,<0
1270155075
o7 05 10

= order_amt

<0y, <05, <
07 5505 ,<0
z,f;/; 2

27, 02)
75 h?q 7

= profit_amt

902,:

3

20;
212

Tog ll2g

<07
.?_30

back_point

0.02

<o 2] <0 75

2
90} /\JQ;

oy
?on

profif_amt
484
20121209 K
Left Y-Axis
@ order_amt 10.8K [:],4
Right Y-Axis
e profit_amt  2.3K K
. 2K
.
0
-2K
-aK
205 . 4 S0y <0y 0y <0y <07, <0y . <t
07,207,207 5207 5207 ,207 520 ,20; ,%0;
25 0270755015501 2501 5700557015701,
1205 1205 1235 127 5 1275 1278 1235 12551235 123,

12
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o When you move your pointer over a single-measure trend chart, a tooltip that provides the
corresponding date appears and the values of the other measures on this date are displayed on
their corresponding trend charts.

order_number order_amt back_point profit_amt

7 34 0.09 -25.9

ol 1

e Highlights for filter interaction and dimension switchover are supported for waterfall charts, scatter
charts, and bubble charts.

e Ticker boards are optimized.

.
20121106

o Images can be added as icons, font sizes can be customized, and diagrams can be added.

Siyle Setlings

Data Label [~

Font Color for Primary Indicator Value [E-

order number

¥ Set Font Size
4 1 6 K Data Label Font Size [ 26 ~
L
Indicator Value FontSize [} 44 »

Alignment

® = Horizontal Center
= Horizontal Left ()

Ticker Board order_number

Image
Conditional Formatting

S 0

11

o order_number
4 .I 6 K Shortcut St...

e oms
|

Series Seffings

oo+ HBE®HEDx

O PN OROLSEND

BEE>®
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Quick BI

o Background colors and background images can be customized.

For more information, see Ticker board.

e Kanbans are optimized.

o Images can be added to kanbans.

order_number

41.6K

. Accessory
order_amt 186K
shipping_cost  1.02K
profit_amt 16.2K
. Chair
order_amt 162K
shipping_cest  1.45K
profit_amt 9.93K
@ e
order_amt 31K
shinnina cast 755

. Appliance

. Bookshelves

. Box

order_amt 160K order_amt 112K order_amt
shipping_cost  1.12K shipping_cost 1.05K shipping_cost
profit_amt 31K profit_amt -5.42K profit_amt
Decorator . Envelop Fax
order_amt 295K order_amt 27 6K order_amt
shipping_cost  2.64K shipping_cost 296 shipping_cost
profit_amt 34K profit_amt 6.6K profii_amt
Machines . Paper Pen
order_amt 223K order_amt 264K order_amt
shinninn cost RB2 shinning cost 2 16K shinnina cast

e Timeline charts and dynamic bar charts are supported.

e Colored maps and geo bubble charts are optimized.

304K
217K
29.7K

154K
358
18.9K

79.6K
Al

& Show Main Indicator Trend Chart
Image Type @ Image Field

Image Field product_type
Conditional Formatting

Series order_numbern(SUM)

Shortcut St..

Synchro...

‘Series Settings

o The Minimal and 3D Filling options are added for the Style Template parameter.

Xinjiang

Heilongjiang
@'
Beging |20
Hebsi
Qinghai Gansu [ ]
sichuan e ™8
Znejang
Guizhou .;mn
§anovons
Hainan

. Heilgflgjiang
] 1, i
Xinjiang § 'Eemﬁg Liaoning
L] 4
Qinghai Ga'nsu fhaﬂdupg
§ [ |
sichuan W i ANUE '
y |
cuzhog ™"l ¢
Guangi
Hallian
|| EEELS

Custom ...

14

> Document Version: 20211224


https://www.alibabacloud.com/help/doc-detail/126957.htm#concept-1340323

. i -Rel tes f
Quick Bl Document History-Release notes fo

r Quick BIV3.12.2

o Map color

m Fill coloris supported. The default background color is gray. If no fill color is specified for a map,
the default background color is applied.

m Border color is supported. By default, no border color is applied.

i \-2
Xinjiang q-'d‘w.__;‘"*-
p

Ny

X

+-

[

. s
order_number 44 i 582K )
order_amt 649 NN 443K

o Fourtypes of basemaps are added.

. /
Heilongji_ang

Heiléhgjiang
& lif” Jilin
1 Xinjiang Beiling Xinjiang Beijing
ot andong +: Gansu  Johandong
e ~Sichuan oD Sichuan ¢ AnhUE
Y g jian,’ & Eujian
order_number 44« ® 582K Gua@\ s order_number 44 = Gualipd
order_amt 649 [ I NI 243K Vialinan order_ami 649 Hainan
-~
= - o/
A }' Heilbhgji‘ang Heilhgjiang
JLE . i [ Jiin
1 Xinjiang [ Xinjiang
o o &I o o Gfig
\ k
{ Gansu gdeng 1 e snandg:g
He, LA =, A LA
oy Anl i hui
» /\’Smnua‘n‘. "l + Sichuag, "@.
B ‘-‘F,tuiar;’ & Fujian
order_number 44 = ® s.82K Guangxi ’ 1 order_number 44 = Guangxi
order_amt 649 I I I 443K Hainan !

order_ami 649 I

Hanan
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o 3D maps are supported.
Colored Map
Northeast Chijgs
Northwest China fsh China
Central China

*:
+
<

order_number 851 [0 NN 10.9K

o Labels can be displayed. Region names and measure values can be displayed at the same time.

Xinjiang

"R.l\_\ 11.8K -

Qinghai Gansu

l‘\,\ 649

W,

order_number 44 <l 5.82K
order_ami 645 ININENENEN 343K

b1 P i
e Wl Sichuan

P A4
j...,_\_. ®
g‘“—f Heilangjiand™
% [28K
® o O
= Liaoning
.%%'_Jgg 240K
® )
5K %
i @ +
® &
alai ap
s ujian = +
L. AT
Guangzi &
176k £

5 I i
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o The measure values in a chart are automatically summed. T his facilitates comparison and analysis.

order_numberTotal 47 4K order_amiTotal 2_ 97 M

Xinjiang
11.8K

P

order_number 44 ® 552K
order_amt 649 [N NN 443K

o The Percentage-based option is supported when you configure the range of colors.

Bubble Color

Interval Divided By

Value-based ® Percentage-based

Coloring Range
Min » Auto Interval Max

% 5

Hierarchical data Auto

Min:

Step 1

Step 2

Step 3

Step 4

Color el oricial

Transparency

Qinghal Gansu

549

128K

Liaoning

BEijifg
b an I 240K
L
SgLSK. ®
Anhu
Chcggqinﬂ' g%%(
598K . v
ey Eujian
A
Guangxi ;

 Auto

1ok

Heilongjiang
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o Fora color map, the three regions with the largest measure values and the three regions with the
smallest measure values are highlighted. For a geo bubble chart, the three bubbles that indicate
the largest measure values and the three bubbles that indicate the smallest measure values are
highlighted.

Colored Map

e \_.z\ Morth China
orthwes [l r?-)n L\J/-{t
v I
o m =
\"‘""-—\_.,J'[ p i ‘I:-‘
outhwest China Ce‘r%tral {
1 +-
+
&

order_number &51 IR 10.9K

o The measure specified for a chart can be changed by selecting another measure from the measure
drop-down list in the upper-right corner of the chart. This helps you perf orm multidimensional
analysis.

Colored Map order_number

= 1

order_number
order_number
profit_amt

back_point

Morth China

iletens
Orinwes ina
LS

outhwest China

rt

<+ +

order_number 851 [ HINENENEN 10.9K
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o Continental maps are supported. Before you create a continental map based on a dimension in a
dataset, you must change the dimension type by choosing Geo > Continent.

Colored Map order_number -

{

+-

Lo

i

851 I 10266

o A specific area can be selected to zoomin.

Bubble Map2
order_numberTotal 47 _4K  order_amtTotal 2_ 97M

o Y L 4
= boy r

- \\\ §

e W /—a‘_." Q:/j‘ .I'\h___,_
\\_ s e Bl ’
Kazakhstan { J
Mongolia ]

{ Heilongjiang

= i

{Istan ~“Rvroyzstap
= {yray
. Tajikisfa

|

= IS

fghanistan;

+ Pakistan_/
R

\

India

order_number 44 « i 582K
order_amt 649 [N 243K

¥, H
Tha_'_lag({—c\ﬁe]l nam
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Quick BI

o Thefilterinteraction feature is optimized. After you click an area in a chart, the associated charts

on the dashboards display data of the selected area.

Bubble Map!

Toa 41.6K o 2.98M

Bubble Map2

ol 41.4K _amtToal 2.97M

Northeast China Heilongjiang
500K g2

North China § S
Northwest Chi 408K

xi ‘ﬁ Lzoning

ina g Bgif gy

217K A 118K 240K
L]

S cont chna
o

Southen China
817K

uuuuu

X B
I B

851 -9 10.9K
S I 517K

1 44«0 582K il
49 N 243K il

For more information, see Filled map and Bubble map.

e LBS heat maps and LBS flying line maps are supported in group workspaces of Quick Bl Enterprise

Standard Edition. For more information, see LBS heat maps and LBS flying line maps.

e Funnel charts are optimized.

o The Perfect Trapezoid layout is supported. In this layout, the width of each layer is not determined
by the measure value. A funnel chart inthe Perfect Trapezoid layout is used only to show values

across stages in a process.

Layout

Default Rectangle PerfectTr...

20
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Perfect Trapezoid

Center

119.07%
East -

B2.54%

91.16%

Mortheast :
50.69%
Northwest .
- 362.68%

South
7.83%

Southwest

Butterfly Chart-Perfect Trapezoid

Center =

order_number

order_amt

6626.70%

profit_amt

shipping_cost
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o Associated areas are highlighted.
Butterfly Chart-Perfect Trapezoid &> & Perfect Trapezoid ]

East =

119.07%

- _
82.54%

91.16%

order_number

order_amt 6626.70%

50.69%

profit_amt

362.68%

7.83%
shipping_cost

For more information, see Funnel chart.

e Word clouds are optimized.

Word Cloud

Envelop Appliance _ ~ band Fax

2 Box Decorator

undefined Telephone
Bookshelves Scissor

For more information, see word cloud.
e Scatter charts and bubble charts are optimized. For more information, see Bubble chart.

The Median Value option is supported for the Axis Value parameter after the four-quadrant
feature is enabled.

e The following types of charts are optimized: line charts, column charts, stacked column charts, 100%
stacked column charts, area charts, stacked area charts, 100% stacked area charts, bar charts,
stacked bar charts, 100% stacked bar charts, and combination charts.
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o Color legends can be sorted. You can configure different colors for different measures on the
Style tab.

Chart Style

Show Labels

Label Display Mode
® Smart Display Full Display
Label Shape

Line Style
® B Smooth Straight

Show Legend

=]
Color
el oficial

. Color '
Dual Y-Axis measure EE I-Cilﬁ'h::lal ~

system
v |

Settings

Functionality

custom |:|

Show Scroll Ba

® AutoFit Show Title Hide

Dimension Value Sampling

® Show Intelligently Auto Hide
Show Most

Null Value Operation

Set to 0, not disconnected
onnected
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stacked area charts.

Quick BI

o Batch configuration of tags is supported for line charts, area charts, stacked area charts, and 100%
Chart Style
Show Labels

Label Display Mode

® Smart Display

Full Display
Label Shape

Line Style

[ ] Smooth

Straight
Show Legend

=]
Color

el oricial

o Alignment of the primary and secondary Y-axes is supported
Line Chart

- order_number
150K

ack_poin - shipping_cost - order_amt - profit_amt
150K
l.II /‘\
100K [ 100K
50K NS 50K
L& \
0 — 0
-50K -50K
201203 201204 201205 201206 8 20120 2001270 20021 20n212
201203 201212
e Tab upgrades

24
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o Charts can be dragged into and out fromtabs.

order_number

41.6K

Tab 1 Tab 2 Tab3 +

o Tab names can be customized.

Tab Tab2 Tab3 +

order_number

29.8K

profit_amt order_amt

319K 2.98M

Click or drag-and-drop to add charts or widgets

order_amt profit_amt

2.98M 319K

o Tabs can be added.

Order information Tab2  Tab3 +

o The order of tabs can be adjusted.

Order information Tab 2 Tab 3 Tab 4 Tab 5 Tabe +

Click or drag-and-drop to add charts or widgets

g.

Click o drag-and-drop to add charts or widgets
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r Quick BIV3.12.2 Quick Bl

o Tabs can be copied.

&

Order information Tab 2 Tab 3 Tab4 Tal Tabe +

Click or drag-and-drop to add charts or widgets

o Thetab bar can be stuckonthe top.

Teb 2 Tab 3 Tab 4 1

Crcss Table of New Version-company_szles_record_en_0710

Tat Layout

® Leit Center

Pie Charl-company_saes_record_an_0710 3ubble Chart-ccmpany_sales_record_en_07°0 Tat Heigh

@ Auto Helght Cuslom Helght

% Top Tah Titla (D

Labels

+ Add Tab Page

Line Chart-company_sales_racord_en_0710

o Auto Height and Custom Height are supported forTab Height.

Tab 3 Tab 4 + Easic Information

v w Title and D
Title

Layout-Underline

Click or drag-and-drop to add charts or widgets

Underline  Vertical Di. Colored B..
Tab Layout

Left Center

Tab Height

Auto Height @ Custom Heigh

Top Tab Title ©
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o The Center optionis supported forTab Layout.

Tab Layout

® |leit Center Right

o Tabs can be copied or deleted.

Click or drag-and-drop to add charis or widgets.

For more information, see .

£l Copy

B Delete

e Two formulas can be used to calculate the percentage of completion that appears in progress bars,

circular bars, and liquid fill gauges.

o Percentage of completion= Actual value/Expected value x 100%
o Percentage of completion=[1 - (Actual value/Expected value - 1)] x 100%

@ Note
value is a negative number.

For more information, see Progress bar.

By default, this formula is used. This formula takes effect only when the expected

e Pie charts are upgraded. For more information, see Pie chart.
o The Decimal Places parameteris added in the Chart Style section.

Pie Chart

Southwest 1.5%
Northwest 7 5%

South 26 8%
North 14.7%

Northeast 15.3%
East 17.2%

Center17.1%

Chart Style

& Show Label

Measure

Decimal Places

Label Display Mode
® Smart Display Full Display

Radius Ratio 100%

Merge Data into Others Category
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Quick BI

o The Enable Indicator Filter parameter is added in the Functionality Settings section.

Pie Chart
20.6K

Tota

Southwest 1.5%
Northwest 7.5%

North 14.7%

Northeast 15.3%

Center 17.1%

South 26 8%

East 17.2%

Basic Information

shipping_cost
shipping_cost
price

order_amt

Chart Style

Series Settings

Functionality Settings

W Enable Indicator Filter

Default

Indicator

o Smart Display and Full Display are supported for Label Display Mode.

e Radar charts are upgraded. For more information, see Radar charts.

o Dimension As Branch Label and Measure As Branch Label are added to the Data tab.

Radar Chart (Dimension As Branch Label)

Southwest

South

Nortihwest

East

North

Northeast
Radar Chart-Measure As Branch Label
= Center = East = North = Northeast = Northwest South = Southwest
order_number
profit_amt way . -—ia order_amt
back_point

Data
Length (Mea )

back_point(SUM)

Labels (Dim.)

area

© Dimension As Branch Label
. Measure As Branch Label

Data S|
Length (Mea_) @4a/10
order_number(SUM)
order_amt(SUM)
back_point{SUM)

profit_ami(SUM})

Labels (Dim.)

area

@ Dimension As Branch Label

O Measure As Branch Label

Filters

28
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Quick BI

o Polygon and Circle are supported forLayout.

Radar Chart (Circle)

Radar Chart (Polygon)

Southwest

Southwest

o

South

Northeast

Northeast

o Smart Display is supported forShow Labels.
o The maximum value for an axis can be configured.
Data

Basic Information

Advanced

Radar Chart-Dimension As Branch Label
order number  w ord
Chart Style

Axes

East
Maximum 5000 Default

.
i \
¥ Show Value

- ‘
4 |
South \ / North

Southwest
% Default

Northeast

Northwest

o Labels onthe vertical axis can be displayed.

Radar Chart (Show Value)
= back_poin

Radar Chart (not Show Value)

Southwest

Southwest

.
v - - == -

South

Northeast

Northeast
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Quick BI

o Aukxiliary lines are supported.

Advanced

Auto Refresh

Filter Interaction

etric Analysis

Gridlines

e Treemap charts are upgraded. For more information, see Treemap.

o By default, measure values are displayed in descending order fromthe upper-left cornerto the

lower-right corner.

o Percentage and Measure are supported forShow Label.

e Polar area charts are upgraded. For more information, see Polar diagrams.

o Polar diagram was renamed Polar area chart.

o By default, measure values are displayed in descending order.

o Label display modes are optimized.

e Story Builderis added. For more information, see Story Builder.

Cross Table
report_date{month) back_point
200901 5.349999999999997
200902 1.02
200903 0.9400000000000002
200904 1.9899999999999995
200905 2.15999999999959993
200906 2.559999999999999
200907 1.8%00000000000003
200908 0.79
200909 1.5800000000000003
200910 1.51

e The annotation feature is supported. For more information, see Label.

order_amt

218768.77499999892
34495.939995559959
38419.4565
58472.799499999994
53094.884999999398
60461.200499999904
46088.6245
20862.1795
£5996.373999959998

45834.784499999994

profit_amt

4597.4% - ‘Bubble Chart-comp

1866.290,

-1099.44

9927.75

7044,38999999995985
1813.54
1177.67

443474

Cross Table

Trend Indicator-cor
Colored Map-comp
Colored Map-comp

Ranking Board-cor
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Quick BI

Document History-Release notes fo
r Quick BIV3.12.2

Annotations can be added to line charts, column charts, 100% stacked column charts, bar charts,
stacked bar charts, 100% stacked bar charts, area charts, stacked area charts, 100% stacked area

charts, and combination charts.

Area Chart
12K -
10.9K
9K
7.85K'Y
H 6.6K,
2 o
£ o
= 6K
=
=
H
3K
0
Center East Norih Northeast orthwe South

area

Southwest

Data Advanced

Advanced Settings

Auto Refresh
Filter Interaction

Hyperlink

Metric Analysis

Gridlines

Trendline

+ Add Label
H Labell & Dimension: Northeast

i Label2 & Dimension: East

e Dynamic playbackis supported for bubble charts and scatter charts. For more information, see

Bubble chart and Scatter chart.

e Aucxiliary indicators are supported for ranking boards. A maximum of three measures can be added as
auxiliary indicators for each ranking board. For more information, see Ranking board.

Ranking Board

Or... province order_number
1 Guangdong  E—— 582K
2 Hubei ] 34K
3 Zhejiang ] 33K
4 Guangxi ] 27K
5 Liaoning I 268K
6 Henan ] 2.35K
7 Hainan L] 234K
8  Shamxi L] 215K
9 Neimenggu 2.07K
10 Heilongjiang 1.68K
11 Anhui L] 1.66K
12 Jlilin | 1.55K
13 Gansu ——— 1.25K
14  Bejing L] 1.16K
15 Tianjin — 963
16 Hebei | 872
17 Hunan L] 840
12 Qhandnnn I FaA

order_amt profit_amt

443K

255K

93.2K

132K

89.5K

853K

56.3K

45.8K

57.2K

16.9K

223K

17.3K

229K

14.8K

14.8K

14.3K

17.3K

11.4K

3.36K

3.72K

1 70K

Data
shipping_cost Category (Dimensions)
279K province
1.78K
1.75K Indicator (Measures)
1.35K =" order_number(SUM)
1.74K
Auxiliary indicators (Mea) & 3/3

1.29K
137K order_ami(SUM)

300 profit_ami(SUM)
113K shipping_cost{SUM)

737

Filters

664

676

777

599

41

323

449

1o

e Conditional formatting is supported. For more information, see Kanbans.
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Document History-Release notes fo

r Quick BIV3.12.2 Quick Bl

Conditional formatting is supported for kanbans, trend indicator charts, ranking boards, ticker boards,
and rich text boxes.

Center East North Northeast ¥ Custom ...
order_number order_number order_number order_number
6.6K 7.85K + 6.48K 591K Text @  icon 8
order_amt 490K ™ order_amt  520K[™ order_amt 403K ™ order_amt 500K [™
Con.. Compare with Fixed Value

Combinati... =

£ value >
Northwest South Southwest £ value =
order_number order_number order_number
order_amt 217K™ order_amt  817K/™ order_amt  24.5K[™

Synchro...

e Images can be added to cross tables and ranking tables.
e The visual effect of trend indicators is upgraded. For more information, see Trend indicator charts.

e Sankey diagrams are upgraded. For more information, see Sankey diagram.

The maximum number of fields that can be added to Node Height (Measures) is increased from5
to 20.

Data

MNode Type (Dimensions)

Mode Height (Measures) & 0/1

e (Cross tables are upgraded. For more information, see Latest cross table.

e Text boxes are upgraded to rich text boxes. You can add text in rich text boxes. For more
information, see Text area.
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Untitled

S Ele B e-|a-

TextBody~ 14~ | B I U A &
[ company_sales_recordLink

I

e Dashboard upgrades
o Filter bars can be added into charts. You can configure filters for each chart.

For more information, see Add and configure a filter bar for a chart.

o Filter bars can be added into tabs. For more information, see Add and configure a filter barfora

tab.

o The Whether to remember query conditions check box is added. If you select Whether to remember
query conditions, all existing query conditions in the organization are saved. For more information,
see Configure the systemto save query conditions.

o The Exclude option is supported when the inquiry mode in a drop-down list is set to Multiple
choice. For more information, see Create a query control.
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Quick BI

e Data of a specific area can be selected to implement filter interaction.

o The Exclude optionis supported when the inquiry mode in the filteris set to Multiple choice. For

more information, see Filter field data.

Field

Center
East
Naorth
Northeast
Northwest
South

Southwest

Add all field values on the left

Added (0)

¢@ Quickin__

=

\‘5\7

B Clear

o After cascading conditions are configured, if you hide query conditions that are not configured in
the first-level filter, the configuration of the cascading conditions is cleared. However, if you hide
the query conditions in the first-level filter, the configuration of the cascading conditions is

retained.

For more information, see Configure conditional cascade.

o The Filter width parameter is supported when the style parameter is set to Tile for afilter bar.

For more information, see Create a query control.

Field style

UnNamed

This feature is supported for line charts, column charts, stacked column charts, 100% stacked column
charts, area charts, stacked area charts, 100% stacked area charts, bar charts, stacked bar charts,
100% stacked bar charts, combination charts, scatter charts, and bubble charts.

34
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o The Show Only option is supported to show only the data in the selected area.

Scatter Chart
@ Anyang @ Changde @ Changsha @ Ezhou @& Hebi @ Hengyang ® Huanggang #® Jiaozuo @ Jingzhou 112
@ Luohe @ Luoyang @ Nanyang # Pingdingshan @ Puyang @ Sanmenxia @ Shanggiu @ Shaoyang -
12K
®
9K
e o
L]
2 6K
o
[ ]
® [ ]
@
e &
D e ® * r
L ]
Se
0 500 1K 1.5K 2K

order_number

o The Exclude option is supported to show only the data that excludes the data in the selected
area.

Scatter Chart

@ Anyang » Changde @ Changsha @ Ezhou ® Hebi @ Hengyang @ Huanggang ® Jiaozuo @ Jingzhou 1413
@ Luohe @ Luoyang MNanyang # Pingdingshan @ Puyang ® Sanmenxia @ Shanggiu ® 3Shaoyang -
12K
9K
®
[+
2 6K
o
L
L] ®
e
]
[ ] o ® -
®
]
1] 500 1K 15K 2K
order_number
[
35
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o The View Data option is supported to show the details of the data in the selected area.

Scatter Chart

@ Anyang Changde @ Changsha @ Ezhou Hebi @ Hengyang Huanggang ® Jiaozuo @ Jingzhou 112
@ Luche ® Luoyang Nanyang #® Pingdingshan Puyang @ Sanmenxia @ Shanggiu Shaoyang v
12K
gk
@
2 6K
o
Y View Data

K e o 15elected

priceTotald 25K

IM‘ . ,.&%‘*
0 @ Show Only [ Exclude [E] Annotate
]

500 1K 1.5K 2K
order_number

o The Annotate optionis supported to allow you to add annotations on the selected area.

Scatter Chart

@ Anyang ® Changde @ Changsha @ Ezhou ® Hebi ® Hengyang Huanggang @ Jiaozuo @ Jingzhou 113
@ Luohe @& Luoyang # Nanyang & Pingdingshan @ Puyang @ Sanmenxia & Shangqiu @ Shaoyang v
12K
9K
L [}
QP
2 BK
o
e
® [ ]
®
) O
¥ . - .
[ ]
LI
1] 500 1K 1.5K 2K

order_number

@ Note The annotation option is supported for the following charts:

m Trend charts: line charts, area charts, stacked area charts, 100% stacked area charts,
and combination charts

m Charts for comparison: column charts, stacked column charts, 100% stacked column
charts, bar charts, stacked bar charts, and 100% stacked bar charts

m Charts that show relationships between data: scatter charts and bubble charts

m Maps: colored maps and geo bubble charts
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o The Drilldown option is supported. You can select an area that contains specific dimensions. T his
allows you to view data in a new chart that is generated based on the selected dimensions.

The following example uses the company_sales_record dataset to show the drilling effect.

Proportion analysis of regional order quantity & Regional sales @2

= order_number  m profit_amt  m order_amt
™

750K

500K

North 52.31%
250K ‘
0 | |
North

Noriheast ~ Northwest South Southwest
area

Northeast 47.69%

Center East

e The combined usage of data drilling and filter interaction is optimized.

o The drilling feature and the filter interaction feature can be used together. For more information,
see Effects of data drilling and filter interaction.

Regional Sales & + @ Proportion analysis of regional order quantity @2
order_number = South mEast mCenter mNomh mNorheast = Northwest  m Southwest
l 33K
l 27K
g
l 1.48K
876
l 269
41
+ 'Eas\ 18.90%
+
Order information <>
area report_date(year) product_sub_type order_level shipping_type product_box order_number
=z Tram TaE 50K =z
East 2009 Appliance
Others Train Large Box 4
Bookshelves L3 Truck Huge Paperbag 4
Box u Train Small Box Eld
Chair Others Truck Huge Box 48
Decorator Al Train Small bag 13
L2 Train Small bag 18
Others Train Large Box 8
Envelop L2 Train Small Box 76

Totet143 < [1]2 3 4 5 6 7 & > | 0/page ¥ | Goto

o The visual effect of filter interaction is optimized.
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o The ;2 iconis provided to cancel filter interaction.

+ & Scatter Chart

@ Center East @ North @ Northeast @ Morthwest @ South ® Southwest

20K

15K
o
=2 10K
j=8

oo
SK
o9
0«
1] 1K 2K 3K 4K 5K

order_number

6K

o Filterinteraction takes effect after you click an area or a field in a chart. You can click a blank area
to cancel filter interaction. In earlier versions, you need to double-click an area or a field in a chart

to make filter interaction take effect.

e The hyperlink feature is optimized.
o Hyperlinks can be created based on time fields.

Hyperlink Selected:  Order profit details @ company_sales_record... View Operation Guide = X
Select a field used for interaction. @ Hyperlink (®) Parameter Extermnal Link
report_date(year) o] Current Report Linked Report
W DefaultWorkspace
>0
W e Dashbo... v Order_profit_details
Effective Field Linked Global Variable: (-]
Linked ... v >HoE B

customer_name
Open in Curj indow Open Pop-up Window
report_date(year)
report_date(quarier)
report_date(month)
report_date(week)
report_date(day)

report_date(hour)

report_date(minute) Cancel
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o Hyperlinks can be created by selecting multiple dimensions.

Cunnipeny_Merkel_Usls

S Hegonal s3ies

Chart Desion

o The Open Pop-up Window option is supported to open a hyperlink.

Hyperlink  sajeciec

Regional sales

company_sales_record...

Open in Current Window

periin Parameter

(® Open Pop-up Window

(® External Link

View Operation Guide > X

Open in New Window

e Themes that use different color systems are supported. For more information, see Theme design.
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Theme Mode

[ |
Light Dark
EE I Official

Official
Cascading ( — I

Cascade Cc

BN orange

..‘ Data Blue

area N
- female fashion

Global Para

EECOmpan’

“ Calm senior

‘ .- Rouge blush

Product_typ

EECOmpan’

Workbooks

e The feature to create workbooks is optimized. For more information, see Create a workbook.

o The Merge Same Cell feature is supported.

File Edit Insert Format Data View

. ¢ » (u] 2 ¢ General < > Microsoft 14 Q  Query Control
(] F. area Data Style Advanced
A B C D E ) )

1 area |J:|rovi nce r_number EersEEIE

2 Henan 2335

3 Center Hubei 3401 ¥ Merge Same Cells

4 Hunan 840

5 Anhui 1655 Slash header

6 Fujian 603

7 Jiangsu 768

8 East Jiangxi 461

9 Shandong 794

10 Shanghai 269 Columns = Rows ]
11 Zhejiang 3304 Display

12 Beijing 1163 ) ® Botiom

N Location

13 Hebei 872

14 North Neimengg 2070 Column Totals Update Daia
15 Shanxi 1415

16 Tianjin 963

17 Heilongjia 1681

18 MNortheast Jilin 1549

19 Liaoning 2680 Column Subiotals
20 Gansu 1250
21 Ningxia 718
22 Northwest Qinghai 44
23 Shanxi 740
24 Xinjiang 244
25 Guangdon 5822
26 South Guangxi 2708
27 Hainan 2336
28 Guizhou 406
- Southwest Sichuan o
30 Aicang 113

o The Cross-Block Align feature is supported.
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o Richtext can be inserted into cells.

Now & red copy, bold copy.

e Configuration items for workbooks are optimized. For more information, see Configure a workbook.
o The order of sheets can be adjusted.

o The watermarking feature is supported.

Forms

The forms feature is added. For more information, see Overview.

@ Note The forms featureisin public preview.

Configuration management

e Users to whomyou want to grant the permissions on Bl portal menus can be selected from user
groups.

Manage Menu Permissions of Untitled

Visual authorization = Volume authorization

Select Menu Set Permissions
Q Available Only to Authorized Users: @ Yes No
* Manage Menu Permissions User Groups Users 8 8
* Level-1 Menu * M Al Groups
test_url

(DSelect a menu item for authorization.

Cloze

For more information, see Bl portal menu permissions.

e The caching acceleration feature is supported. Data Lake Analytics (DLA) can be used to accelerate
queries on MaxCompute data sources.

For more information, see Configure an acceleration engine.

e The Organization page is optimized.

Unpublished charts
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e Hierarchy charts are unpublished.

The entry points to create hierarchy charts and switch other charts to hierarchy charts are removed.
Existing hierarchy charts can be displayed but cannot be switched to other types of charts or edited.

e LBS trail maps and LBS dynamic trail maps are unpublished.
Existing LBS trail maps and LBS dynamic trail maps cannot be normally displayed or edited.
e Text boxes are upgraded to rich text boxes.
The following features supported by text boxes are unpublished:
o The font configuration item unpublished. Existing text boxes that apply fonts can be deleted but

cannot be edited.

o The strikethrough configuration itemis unpublished. Existing text boxes that apply strikethroughs
can be deleted but cannot be edited.

e Pivot tables are unpublished. The pivot table option displayed in the navigation bar is replaced by
the cross table option. Existing pivot tables can still be used and can be switched to cross tables of
the latest version by choosing Style > Switch Versions.

e Filter bars can no longer be moved onto tabs but can be directly created on tabs.

e Theicon used to create cross tables of earlier versions is removed fromthe navigation bar. You can
choose Style > Switch Versions to switch cross tables of the latest versions to cross tables of earlier
versions. Cross tables of earlier versions can still be used. You can choose Style > Switch Versions to
upgrade cross tables of earlier versions to the latest version.

Basic Information

» Show Title and Description

Title

Cross Table

Description

Endnote

Show Link

>ross Table of a Later Viersion
ss Table of an Earlier Version

Switch Versions
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e Measures in word clouds are automatically sorted in descending order on the Data tab. The sorting
order can no longer be configured.

@ Note Before you upgrade Quick Bl, evaluate the impact on your business. If you have
questions, contact Quick Bl technical support.
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2.Quick Bl V3.7.4 release notes

Release date
October 2020

New data source features

A data source can be replaced with another. After you replace a data source, you can continue to use
the datasets and dashboards that are created based on the original data source.

) Notice

If you replace a heterogeneous database that is used as a data source with another

heterogeneous database, SQL statements for ad hoc queries in the original database may not be
properly executed and calculated fields in the original database may not be properly used. Perform

this operation with caution.

Data Sources

My Data Sources

= oracle

For more information, see Manage data sources.

&lz @

New dataset features

e CustomSQL statements of ApsaraDB for HBase can be used to create datasets.

e The variable type Date-Year and Week is added.

Parameter Settings @

<+ Add Variable ‘ | [*] Extract Variable
Variable Name Variable Type
order_number Number
report_data Date-Year and Wesk
order_leve Strin

Actions

For more information, see Create a dataset.
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New dashboard features

e The chart type decomposition tree is added.
e Chart design is optimized.
o The font size of a kanban can be adjusted even if the dimension is not specified.

Indicaior Seitings

Maximum Indicators Each Row
Hide Dimensions

Hide Primary Measure Name

Font Color for Primary Indicator Value [~

Main Font Size [ 24 ~

Sub-Font Size E 12 ~
Indicator Block Alignment
= Horizontal Left &
[ ] = Horzontal Center

Indicator Alignment

® o Align Left = Center
Center East Morth Northeast
price price price price
32K 28.2K 18.4K 22.1K
Northwest South Southwest
10.2K 32K 1.16K

For more information, see Kanbans.

> Document Version: 20211224 45


https://www.alibabacloud.com/help/doc-detail/55685.htm#concept-k5j-cr2-vdb

[ -Quick BIV3.7.4 i
Document History- Quic 3 re Quick BI
lease notes

o Trendlines are changed to full displays of trends in trend indicator charts.

order number order amt back point

228.00 21.46K 0.40

-
—

For more information, see Trend indicator charts.
o The design of colored maps and bubble maps is optimized in the following aspects:
m Border thickness and color
m Background color
m Location style
o [f the display style of fields in a query control is set to Drop-Down, a load-on-demand mechanism

is used.
o The font size of labels is decreased to display more labels in pie charts.

band 1.29% - 12.16%
e Telephone 12.16%
Bookshelves 3.77%

Fax 5.18%
Appliance 5.38% Table 10.39%
Chair 5.44%
Box 10.19%

J:‘.CC'E'SS'JI":,' 0.2 270

Machines 7.45%

undefined 8.34% Paper

For more information, see Pie chart.
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o The margins of vertical bar charts, horizontal bar charts, and combination charts are decreased to

display more data.

™

800K

600K

Calculate

400K
200K .
0 [ —

area
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o A default view, error view, and loading view are added for each chart type.

Default view

Error view

Line Chart

Loading view

Line Chart

Data is being loaded.
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o The font of numbers in dashboards is changed to Alibaba Sans.

order_number

I

Progress Bar-company_sales_record_en

51.0%

o The colors forslices in a pie chart can be customized.

Others Category options are added.

Pie Chart-company_sales_record_en

oz 2.98M

a
& Show total

Show Legend

Pie chart color

Color

EEEEll Business -
Series Settings

Telephone v | ] |
Table .. ..

Pie Chari-company_sales_record_en

» Show Label

# Dimension
& Percentage

Radius Ratio

10

¥ Merge Data into Others Category

Pie Chart-company_sales_record_en

Toial 2.98M

Chart Type

w Show Label

& Dimension

& Merge Data into Others Category
4

» Show lotal

For more information, see Pie chart.

The Show total and Merge Data into
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o The maximum and minimum values in a bubble map or colored map can be highlighted in a
specified color.

Bubble Map-company_sales_record_en

For more information, see Bubble map and Filled map.

o The Custom Background option is removed fromthe Style tab. The background color is subject
to the chart color settings.

@ Note The Custom Background option is removed for the Tab widget and the
following chart types: line chart, vertical bar chart, stacked vertical bar chart, 100% stacked
vertical bar chart, horizontal bar chart, stacked horizontal bar chart, 100% stacked horizontal
bar chart, area chart, stacked area chart, 100% stacked area chart, circular bar, waterfall chart,
combination chart, scatter chart, bubble chart, faceted scatter chart, radar chart, polar
diagram, colored map, bubble map, LBS heat map, LBS bubble chart, LBS flying line map, trend
indicator chart, Sankey diagram, and flow analysis chart.

For more information, see Line charts.

o The arrow colors are optimized for cross tables, kanbans, trend indicator charts, and ranking
boards. The arrow colors are changed based on the system language.

If the system language is Chinese, the upward arrow is in red color and the downward arrow is in
green color.

If the system language is English, the upward arrow is in green color and the downward arrow is in
red color.

Functionality Settings

Emable Indicator Filter

Series back_point

+ Enable Conditional Formatting

Mark ... -

v  When

- v When..

v When..

o Thetooltip is displayed for all charts by default.
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New workbook features

e The workbook edit page is reconstructed. The following table describes the details.

Earlier version V3.7.3

o Allicons are displayed on the toolbar.

& Lt

neral (123 @ Ba S 6% (BB 2 B ¥
p: MB4EE Q| V syie B ] Theme

e

o To import data, you must click the [=] icon.

o Afilter baris provided to associate datasets.
o The camera feature is provided.

o The highlight pivot table feature is provided.
o The chart is not elegant.

o Hidden sheets are difficult to find.

o |cons are displayed as cascading menus for easy
locating.

o To import data, perform either of the following
operations:

® Click the i icon and import the data.

® Choose Insert > Dataset and import the
data.

o The filter bar is upgraded to a query control,
which has the same functions as the query
control widget in datasets.

o The camera feature is unpublished.
o The highlight pivot table feature is unpublished.

o The visual effect of charts is improved.

o The sheets in a workbook are optimized in the
following aspects:

= A hidden sheet is marked with the @ icon for
easy identification.
® You can click the := icon to view the sheet

list.

For more information, see Configure a workbook.
e The following features are unpublished:
o Highlight pivot table

o Camera

@ Note Before you upgrade Quick BIto V3.7.3, evaluate the impact on your business. If you
have any questions, contact Quick Bl technical support.
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3.Quick Bl V3.6.3 release notes

Release date

April 2020

New data source features

e Query result caching and management are supported for all data sources.
e The date filter forthe Presto data source is optimized.
e Data Lake Analytics is supported in Quick Bl Basic.

New dataset features

e Five-level directories are supported in dataset folders.

New Bl portal features
Bl portal Uls are optimized in the following aspects:

e Four-level menus are supported.

e The theme color can be customized.

For more information, see Bl portal overview.

New dashboard features
e Funnel charts are updated. The visual style can be specified, and the chart type can be configured.
For more information, see Funnel chart.

e The tornado-leaned funnel chart is renamed butterfly chart. The visual style can be specified, and
the chart type can be configured. For more information, see Butterfly chart.

e Bubble maps and colored maps are updated in the following aspects:
o The style template, color, and number of intervals can be configured.

o Maps of the following countries are supported: China, Singapore, Germany, Mexico, Japan, and the
United States. Maps of a country or area can be displayed.

o Local zoom-in, zoom-out, and drag operations are supported. This allows you to conveniently
view data of an area.

o The geographical location names in the chart are updated to the standard national geographical
location names of the latest version.

For more information, see Bubble map and Filled map.
e The Style tab of pie charts is updated.
The slices are arranged clockwise fromthe first quadrant in descending order of weights.

o

o

If the number of slices is small, the slice boundaries are displayed.

o

Visual Style can be set to Pie or Ring.

o

Show label can be set to Dimension, measure, or percentage.

For more information, see Pie chart.

e The Style tab of word clouds is updated.
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o The Style Settings section is added. You can configure the word cloud shape and specify whether

to display text vertically in this section.

o The Series Settings section is added. You can specify Display Name and Number Formatting forthe

measure in this section.

For more information, see Word cloud.

The chart styles and configurations of kanbans, gauges, and progress bars are optimized. Dynamic

target values can be configured for gauges and progress bars. For more information, see Kanbans,

Gauge, and Progress bar.

query control.

Theme settings and filter interaction are supported for more chart types.

The time configuration dialog box is closed immediately after you select minutes and seconds in a

Fluctuation analysis is supported for bar charts and line charts in Quick Bl Enterprise Standard. T his

feature analyzes the causes of data fluctuations. For more information, see Metric analysis.

Dashboards can be unpublished and restored. The publishing states of dashboards are displayed. For

more information, see Save, save and publish, restore, unpublish, and republish a dashboard.

New functions of the query control are added. The Uls are upgraded in the following aspects:

o Smart selection is supported for associated fields in the same dataset.

o Fields in different datasets can be selected in a query control.

o Time fields in different time granularities can be selected in a query control.

o Query Value Field and Display Name Field are displayed.

For more information, see Create a query control.

e The comparison feature is optimized. When Data Settings is set to Percentage Difference, you can
specify a calculation formula. If the value of the previous period is less than 0, the formula takes
effect. Otherwise, the default formula is used. For more information, see Configure a chart.

Comparison Settings (.

X

e The hidden Bl performance analysis tool is added to the dashboard preview page.

The performance analysis tool is displayed on the report browsing page if you append

ue tothe URL.

&usePerf=tr
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e I|n afull-screen dashboard, only eleven types of charts and three widgets that are commonly used

are reserved.
Reserved components (3 widgets and 11 charts)

widgets: Text Area, iFrame, Image

Charts:

o Line chart and area chart

o Vertical bar chart and horizontal bar chart
o Pie chart

o (Cross table

o Colored map and bubble map

o Kanban and ticker board

o Ranking board

Unpublished components (27 types of charts)

o 100% stacked area chart and 100% stacked
vertical bar chart

o Stacked area chart, stacked horizontal bar chart,
stacked vertical bar chart, circular bar, and
waterfall chart

o Combination chart

o LBS bubble map, LBS heat map, and LBS flying
line map

© Trend indicator
o Gauge, progress bar, and liquid fill

o Scatter chart, bubble chart, and facet scatter
chart

o Funnel chart and butterfly chart
o Radar chart and polar diagram
o Treemap and hierarchy chart

o Word cloud

o Sankey diagram and flow analysis chart

@ Note Youcannot create a chart of the unpublished type or switch the current chart to the
unpublished chart type. The inventory charts of the removed types are displayed properly.

However, their chart types cannot be changed.

The standard dashboards are not affected.

New mobile device features

e The display of query control on mobile devices is optimized.

New workbook features

e Workbooks can be unpublished and restored. The publishing states of workbooks are displayed. For
more information, see Save, save and publish, restore, unpublish, and republish a workbook.

Other new features

e APIStatistics Overview is added to the Open Service feature in Quick Bl Enterprise Standard. T his
allows you to view details about APl operations called. For more information, see API statistics

overview.
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4.Quick Bl V3.5.2 release notes

Release date
April 2020

New data source features

e The following cloud data sources are supported: DRDS, TSDB, and HBase.

e The following user-created data sources are supported: Hive, Vertica, SAP IQ (Sybase 1Q), SAP HANA,
and IBM DB2 LUW.

e The data source (ADS)Analytic DB is renamed AnalyticDB for MySQL 2.0.

New dataset features

e The Custom SQL feature is renamed Ad Hoc Query. This feature offers the following functions:
specifying a data source, formatting SQL statements, and creating datasets by using saved custom
SQL statements. For more information, see Use ad hoc queries for data modeling.

e Dimensions of all hierarchy levels can be duplicated, hidden, and deleted. The first day of a week can
be customized for the week dimension. For more information, see Edit dimensions and measures.

New dashboard features
e The following chart types are supported: combination chart and scatter chart. For more information,
see Combination chart and Scatter chart.

e The loading user interface (Ul) for a ticker board is optimized. Color Palette is added to the Custom
Background section on the Style tab. For more information, see Ticker board.

e The scatter chart is renamed facet scatter chart. For more information, see Facet scatter chart.
e The bubble chart is optimized. For more information, see Bubble chart.

e The following functions are supported for cross tables and pivot tables: wrapping text, renaming
totals, and setting data bars with conditional formats.

e Displaying a chart in full screen and exiting full screen are supported. For more information, see Full-
screen mode.

e The tab style, advanced settings, and comparison settings of charts on a dashboard are updated.

e The Metric Analysis feature is supported. For more information, see Metric analysis.

Other new features

e The development and access modes are supported. For more information, see Access mode.

e Report embedment and data service features are added to the open service feature. For more
information, see Report embedment and Data service.

e The permission type can be configured when you share a data object. This allows you to authorize a
user only to view or download the data object.
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5.Quick Bl V3.4.3 Release Notes

Release date

Quick BI

January 2019

New data source features
e The cloud data sources Presto, AnalyticDB for MySQL 3.0, PolarDB for MySQL, and the user-created
data source Presto are added.

e Forthe AnalyticDB for MySQL 2.0 and AnalyticDB for MySQL 3.0 data sources, the Name field is added
to select a database and available AnalyticDB databases are automatically displayed.

New dataset features

e New aggregate functions such as median, variance, and standard deviation are added to datasets.

e Parameters of ad hoc query are added to the Filter Bar widget. Dynamically passing parameters to
SQL statements, and check and processing of the syntax and placeholders by using FastSQL are
added to the Ad Hoc Query page. For more information, see Use ad hoc queries for data modeling.

e Filterinteraction for datasets is upgraded. This feature supports a five-level horizontal filter
interaction on data tables and fuzzy match for joined data tables by using data table names.

New dashboard features
e The Compound Query Control icon is added to the dashboard edit page. For more information, see
Compound query control.

e The Filter by Condition section and Lock Filtering Conditions (You cannot change the
filtering conditions after preview.) are added to the Set Filter page. After you select Lock
Filtering Conditions (You cannot change the filtering conditions after preview.), the
filtering conditions cannot be changed on the preview page.

e The Sankey diagram, waterfall chart, ranking board, ticker board, and trend chart are added. For more
information, see Sankey diagram, Waterfall chart, Ranking board, Ticker board, and Trend indicator
charts.

e The flow analysis chart is optimized. For more information, see Flow analysis chart.

e The Make Public icon is added to the dashboard edit page to allow users to set a public URL.

4

Make Public

e Four-level cascade filtering is supported.

e The Permission Type field is added to the Share pane.

New Bl portal features

e The menu permissions on a Bl portal take effect immediately after you grant themto a user.

Other new features

e The tag addition function is supported for tag management.
e The Screenshot(mobile) option is added to Email Subscriptions, which increases the maximum pixels
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of animage that can be sent in an email from 4,000 pixels to 8,000 pixels.

e Multiple recipients can be selected at a time.
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